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1. Purpose of this document and last revision of this document

These notes are mostly based on the Latex Course from the High School of Economics [1]. To create these
notes other materials [2],[3],[4] have also been used . But the most important inspiration have been
obtained from [1].

Date and author Comment

04-APR-2020, Konstantin Burlachenko Initial draft

04-APR-2020, Konstantin Burlachenko Fix English grammar

30-APR-2020, Konstantin Burlachenko Some updates with new commands
16-MAY-2020, Konstantin Burlachenko Update reference section

2. Why Latex is useful

The main ideology of Latex is “Think more about the content”.
LaTeX is a high-quality typesetting system.
LaTeX is the de facto standard for the communication and publication of scientific documents.

Due to a huge number of open-source packages and customizing, the possibilities with LaTeX are endless.
The people from the computer science background can be considering Latex as Domain Specific Language
for typographic work.

3. Document structure

3.1 Content structure
In term of sections information in the Latex, the document is structured typically in the following way.
The concepts are listed from bigger concepts to a more detailed one.

Structural part of document Meaning

Part Parts of books, like volume. “Article” does not have such a concept.
\part{Part Name} - Command creates an enumerated part
\part*{name} - Command creates not enumerated part

Chapter Such a concept is presented in books and reports, an article does not
have such a concept.

\chapter{Chapter Name} - Command creates enumerated chapter
\chapter*{name} - Command creates not enumerated chapter

Section It's the main concept of the article to start new sections in the
document

\section {Section Name} - Command creates an enumerated section
\section*{Section Name not enumerated} — Command creates not
enumerated section

Rule of thumb if you don’t want to numerate section use extra *.
Subsection Part of the section if you want to layout text conceptually in finer
granularity

\subsection{Subsection Name}




SubSubSection Name of sub-sub section.
\subsubsection{Sub-sub section name}

Paragraph \paragraph
\paragraph*

SubParagraph \subparagraph
\subparagraph*

3.2 Tex File structure
File which store instructions to create a final document (presentation, article, book, etc.) has extension
* tex and from point of view of filesystem are text (not binary) files.

From birds-eye-view *.tex files have the following structure.

\documentclass{...} % Declares document type

Commands placed here are called the preamble. They contain commands which affect all document.
Some examples:
% Include some popular American Math Society packages.

\usepackage{amsmath,amssymb,amsfonts,amsthm}

% This is the encoding for the document text file.

\usepackage[utf8]{inputenc}

\begin{document}

From this place you insert commands relative to document content.

\end{document}

You can store comments or temporary text underneath \end{document} command. They don't have
implications in the result document from the point of view of final generated PDF document.

4. Common aspects for all Latex commands

When you use Latex you create text content and also provide Latex system with commands which are
intermixed with content. You need special commands, for example, for the purpose of creating tables or
formulas. There are a lot of commands in Latex. But there are common aspects of all commands which |
have found for myself while looking into the course [1]. And let's start from them.

Aspect Description

\command Notation to write command




{}

Curly braces are used to separate arguments in
commands

\{\} You should use backslashes if you really want to
output curly braces
\sim Tilda symbol ~ is reserved in TEX, so it's more easier

to use this command.

\command_name {argument-1} {argument-2}

The notation to write command with several
arguments

How include Greek letters?

Option-1: Have a keyboard with Greek letters
Option-2: Use specific commands like \alpha

New Line A newline is treated as a space symbol.
“Space symbols” inside math equations are ignored.
Several “Space symbols” inside text are reduced to a
single space.

\\ Forcing the movement of text to a new line without
creating a new paragraph.
The double new line in source *.tex file (via typing
“Enter” two times) creates a new line but also starts
a new paragraph.

\command* Very often in Latex, each command has alternative
command notation, but with star “*”
The * notation removes counting.
The reference to the object can be created via
\label{unigue name}.
You can reference only to numerating objects.
Reference to the labeled object can be created via
\eqgref, \ref, \pageref commands.

mm,cm,in Absolute units for size
Definition of sizes in millimeters, centimeters, and
inches. This is the absolute size which does not
depend on paper size or scales.
Relative units for size

em, ex em - Width of letter “M” in current font.

ex — Height of letter “X” in current font.




\pagewidth Width of page.
\textheight Height of text.
\textwidth Width of text

Another page metric concepts can be checked here:
https://en.wikibooks.org/wiki/LaTeX/Page Layout
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% This is a single line comment Single comment line
% Environment block Latex includes separate commands which are
\begin{env.name} intermixed with text content, but also allow to have
% Some text and commands special "environment blocks" dedicated to tables,
\end{env.name} formulas, etc.
\, Small space between nearby letters.
Useful during typing title of the work.

5. TexStudio useful Features

Here | will list some features of TexStudio which are useful during create Latex documents in it. TexStudio
can be considered as IDE for Latex.


https://en.wikibooks.org/wiki/LaTeX/Page_Layout
https://www.texstudio.org/
https://www.texstudio.org/

Action

Implication

Wizard->Quick Tabular

Creating a table via using the graphical wizard

Latex->Manipulate Tables

Wizard provides the functionality to add row or column into the table
and things like that

Bibliography->Article

Generate bibliographic description which should be saved in a file
with extension *.bip

Latex->List Environments

Latex code generation for lists

Hovering the cursor over the
starting symbol of inline math
mode

Hovering the cursor over the starting symbol of inline math mode,
S, or over \begin{equation}.

TexStudio gives a preview of a math equation.

Select Latex Test with mouse
and type F7

It’s a shortcut for “Go to PDF”.
This command highlight part in final PDF document which is
correspond for this command.

F5 Compile Latex to PDF and update preview

F6 Compile Latex to PDF

CTRL+T Comment/Uncomment selected lines

CTRL+B Insert “\textbf” command to make selected text as bold

CTRL+ Insert “\textit” command to make selected text as italic

CTRL+Z Undo previous command

CTRL+K Remove current line with latex commands

CTRL+F One CTRL+F is standard search in document. If you will press CTRL+F,
then will input search text, and then you will press CTRL+F one more
time then it will bring to search all occurrences of search word in tex
file.

Options->

Configure-> More better bibliography tool which works with Unicode fine

Build->

Default Bibliogrpahic Tool ->
Biber

File->New From Template

Create a Latex document from one of the templates which are
provided by TexStudio.




“Latex” in main menu

Contains a lot of useful commands for Latex

Wizard->QuickStart
Wizard->QuickBeamer

Create default article, book, etc. via selecting specific options in the
wizard

Wizard->MathAssistant

Allow draw formula with mouse and generate Latex code for it

Symbols in the left panel

There is a big pallet of special symbols from which it’s possible to
select

Open PDF in PDF Viewer

There is just button to open PDF, not in previewer with built-in zoom,
But in PDF Reader

CTRL+Space

Auto-completion feature, like in programming IDE.

Options->
Configure TexStudio->
ShortCuts

Observe different shortcuts for different wizards, etc.
And ability to setup own shortcuts

Help->Latex Reference

Usefull one big page reference with different Latex commands,
grouped into categories. “LaTeX2e unofficial reference manual”

6. Some Preamble Examples
Preamble contains command to turn on specific packages, provide meta-information about document,

setup various layout and anything relative to specific book style, journal, etc.

Command

Description

\mathtoolsset(showonlyrefs=true)

Show only formulas numbers for which we have
reference via \eqref

\documentclass[ad4paper, 12pt, leqno]{article}

Numerate equations and make numerations
from the left

\documentclass[a4paper, 12pt,
legno,twocolumn]{article}

Create two column article

\usepackage{graphicx}

Include package related to work with graphics
features

\usepackage{amsmath,amssymb,amsfonts,amsthm} Packages related to mathematics into *.tex

document
\title{First doc} This is the title.
\author{Jane} The name of the Author(s)




\thanks{extra credits}

Useful if you need to thank an institution in
your article.

\date{February 2014}
\usepackage{extsizes}

Allow use non-standard font sizes

\usepackage{geometry}
\geometry{top=25mm}
\geometry{bottom=35mm}
\geometry{left=35mm}
\geometry{right=20mm}

Simple way to setup margins

\ usepackage {fancyhdr}

\ pagestyle {fancy}

\ renewcommand {\ headrulewidth} {Omm}
\ Ifoot {Bottom Left}

\ rfoot {Lower right}

\ rhead {Top Right}

\ chead {Top in the center}

\ Ihead {upper left}

% \ cfoot {Lower in the center}

% By default, here is the page number

Headers and footers. Thickness of the ruler that
marks out the header

\usepackage{setspace} % inter line distance
%\onehalfspacing % x1.5

Specify inter line distance.
It’s a distance between adjacent lines in final

%\doublespacing % x2 document
%\singlespacing % x1
\usepackage{lastpage} Obtain number of pages in document

\usepackage{hyperref}

Create real hyper-reference inside document.
Now you can click into various references
created with \ref like commands.

\hypersetup{} allow to setup colors for different
links mode used in hyper-links

\renewcommand{\familydefaulti{\sdefault}

Setup default font without serifs
(Like Arial)

\usepackage{cmap} % Search in PDF
\usepackage{mathtext} % Allow Russian letters in
equations

\usepackage[utf8]{inputenc} % Source file encoding
\usepackage[T2A]{fontenc} % Encoding
\usepackage[english,russian]{babel} % Localization

Turn on Russian letters processing inside TEX
document (Encoded in UTF-8 format)




\frenchspacing

7. Commands

There are a lot of commands in Latex. The classification used below is only my classification to easily
navigate between different commands in future.

7.1 General Content Commands

Command

Description

\documentclass {class}

Article - Usual article
Report - Usual report
Book - Template for book
Beamer - Presentation slides

\label{name}

Attach label to any part of document

\ref{name} Reference to label
\pageref{name} Reference to the page with the label
\egref{name} Reference to equation

% single line comment

Comment for the whole line, ending with newline

Spaces in single line.

Several spaces equivalent to single space

New Paragraph Please leave one or more single lines to make new
paragraph.
\begin{center} center - alignment horizontally by the center of the page

Images, Tables, formulas here will be
aligned to center

flushleft - alignment horizontally by the left part of the page
flushright - alignment horizontally by the right part of the

\end{center} page

\textbf{This is bold text} \\ Commands to make text bold, underline, italic.
\underline{This is underline text} \\

\textit{This is italic text} \\

\textbf{\textit{This is bold and italic
text}}

\begin{itemize}
\item First item in non-numerated list

\item Second item in non-numerated list

\end{itemize}

Non-numerated list (or unordered list) of items.
Each item should be started with \item command.

\begin{enumerate}
\item First item in enumerated list

Numerated list (or unordered list) of items.
Each item should be started with \item command.




\item Second item in enumerated list
\end{enumerate}

\newpage

Move to the next page

Command to print size of different fonts

\begin{table}[h!]
\caption{Font Sizes}
\centering
\begin{tabular}{|c|c|}
\hline \verb|\tiny|

\hline \verb|\small|
\hline \verb|\normalsize|
\hline \verb|\large |
\hline \verb|\Large|
\hline \verb |\LARGE |
\hline \verb|\huge|
\hline \verb|\Huge|

\hline \verb|\scriptsize|
\hline \verb |\footnotesize | & \footnotesize relative small \\

& \tiny extremely tiny \\
& \scriptsize very tiny\\

& \small small \\

& \normalsize normal and default size \\
& \large big \\

& \Large more bigger \\[5pt]

& \LARGE very big \\[5pt]

& \huge large \\[5pt]

& \Huge exremely large \\ \hline

\endf{tabular}

\endf{table}

\Large This command in fact change the size of the font and it does
not accept any arguments.
Everything after this command will be in Large font.

\begin{Large} Alternative to change the font size. Place text in

Large text environment block with Large markers

\end{Large}

7.2 Math Content Commands

Command

Description

$2+2=4$

Mathematical formula inline mode is injected into main text.
Alternative syntax to S pair are:

1) \(\) pair

2) \begin{math}\end{math} pair

\[2+2+x_3=4\]

This mathematical formula obtain own separate line.
This math formula mode is called displayed mode, opposite
to previously mentioned inline mode.

10




Alternative writing style use the following environment
block:
\begin{displaymath}
2+2+x_3=4
\end{displaymath}
This is unnumbered display mode

S \displaystyle S

Use displaymode inside inline math mode.
It affects the height of symbols in math formula.

\begin{equation}\label{my_equation}
xX_1=2+2
\end{equation}

The equation in “environment block” in \begin \end block.
The formula is shown in displayed mode and obtains its own
number. Formulas are numbered in display mode

\egref{my_equation}
\pageref{my_equation}

Reference to the equation.
Reference to the page with equation..

\left( Parenthesis with automatic height selection.
\right) It can be used to create parenthesis for a system of
\left\{ equations.

\right\}

\left. Phantom bracket.

\right.

Sometimes you should create unbalanced parenthesis, but
from a syntax point of view, Latex does not like unbalanced
brackets.

To mitigate this problem you should use “phantom bracket
feature”

\begin{multline}
1+2+3+\\
4+45+6+\\

7+8+9
\end{multline}

Special formatting used for print long formulas.
“multiline” automatically brings us to math mode.
\\ is a newline.

The equation in this block obtains one single number.

\begin{align}
2+3&=5 & 66+8&=74\\
3+33&=6 & 7+5000&=5007
\end{align}

Each equation obtains its own number. “align”
automatically brings us to math mode.

\\ - is newline

& sign - in the odd position used as a marker for alignment
with each equation.

& sign - in even position used as a marker for a new column.

11




\begin{align*}
2+3=5\\
3+3=6
\end{align*}

Similar to \begin{align} “align” automatically bring us to
math mode.

But “align*” means turn-off formulas counting.

\begin{equation}
\begin{aligned}
2+3&=5 & 66+8&=74\\
3+33&=6 & 7+5000&=5007
\end{aligned}

Similar to “\begin{align}’, but all formulas obtain single
number for block of formulas.

“\begin{aligned}” do not automatically bring us to math
mode. So there is a need in us “\begin{equation}”

\end{equation}

\text{my text} Command used to inject text into place where math formula
is typing

\[ Function partially defined for different domains parts

| x|=\begin{cases}

x, &\text{if } x \ge O\\

-x,&\text{if } x < 0

\end{cases}

\]

\[ Define matrix.

\begin{pmatrix} You should not define shapes, parenthesis.

a_{11} & a {12} & a_{137\\
a {21} & a {22} & a {23}

Only necessary thing to type items and separate them with
& in one row, and separate two matrix rows with \\

\end{pmatrix}

\l pmatrix — parenthesis are used to define matrix
vmatrix — vertical lines are used to define matrix
bmatrix — square brackets are used to define matrix

\tag{S} Instead of counting formulas use tag “S”

\| Two parallel vertical lines. See another symbols here.

7.3 Specific Letters and Math Operators

Command

Description

\frac{numerator}{denominator}

Fraction.
If you use equation inside S $, then numerator and
denominator will be typed in small font size.

If you type formulas inside \[ and \], then size will be fine.

\dfrac{numerator}{denominator}

Fraction with the same size of numerator and denominator
as the main text.

12
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\times

One possible command to create multiplication.

Sb=\sin xS \In \sin and other standard math functions are well-known
to Latex and Latex can type them nice.
You only should write them in math mode with using
backslashes.
Even more, you can declare your own math operator via
using \DeclareMathOperator command in the preamble of
the document.

\ne Math sign: Not equal

\ge Math sign: Greater or equal

\cap Math sign: Sets intersection

\cup Math sign: Sets union

\bar Diacritic sign: Append bar on top of math expression

\tilde Diacritic sign: Append tilde sign on top of math expression

\overline Long line over symbols

\widetilde Long tilde

\phi Small Greek phi letter

\varphi Small Greek phi letter in alternative style

\Phi Big Greek letter Phi

\epsilon Small Greek epsilon letter in alternative style

\varepsilon Small Greek epsilon letter in alternative style

\dots

7.4 Graphics and Tables Latex Operators

Command

Description

\includegraphics
[width=200px,
height=200px,
keepaspectratio=true]
{img.png}

Include image in
Raster format (*.jpg, *.png) or
Vector format (*.pdf)

Please append into preamble
\usepackage{graphicx}
\graphicspath{{my_image_path_1Kmy _image path_2}}

\begin{tabular}{|c|cc|}
\hline
1&2&3\\
\hline

Table with 2 rows and 3 columns.

|[c|cc| - encode center alignment in each column and places
of vertical lines

\hline —is horizontal line between adjacent rows
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48&5&6\\
\hline
\end{tabular}

\\ - is new row
& - delimiter between adjacent items

\begin{tabular}{|l| cr|p{10cm}|}

\hline

rowl,coll & rowl,col2 & rowl,col3 &
rowl,col4 \\

\hline

S\displaystyle \frac{2}{3}$ & row2,col2 &
row2,col3 & row2,col4 \\[10mm]

\hline

\endf{tabular}

Append Table.

Table contains 4 columns — first column align to left, 2™
column aligned to center, 3™ is aligned to right,

4™ column has specific fix width.

There is no vertical border between 2" and 3™ column.
\hline - command will draw horizontal line

& - is column delimiter, similar to delimiter used in typing
matrices.

Inside the table in this example it have been shown how to
include math formulas in inline mode.

\\[10mm] — make newline and append extra spaces.

Another alternatives for draw tables and environment
blocks with tabularx, tabulary

\begin{table}[h]
\begin{center}
\caption{My table}
\label{my_table}
\begin{tabular}{|c]| |cc]|}
\hline
1&2&3\\
\hline
4 & \multicolumn{2HcH5,6} \\

Align table to center.

Create a caption for table and number.

Create a reference for the table.

Create a table with all columns aligned to center, after the
first column, there are double lines down.

\multicolumn creates a column from two nearby cells, align
by the center, and type text “5,6”.

For combine several rows there is a command \multirow

\usepackage{multirow}
\usepackage{array}
\usepackage{longtable}

\begin{longtable}{|c|c|}
\caption{Long Table} \\

\hline
\hline create complete horizontal line, which spans all
\cline{1-2} columns. \cline here creates horizontal line spans columns:
\end{tabular} 1-2
\end{center}
\end{table}
Long table.

% To append support of long-table append following in preamble

14
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\hline
\textbf{Column A} & \textbf{Column B} % Page head with bold text
\endfirsthead % Marker for end of first head (main header)
\hline
Column A & Column B % Automatic column names text in new pages
\endhead % Marker for end of the extra headers duplicated in each page
\hline
\hline % Foot note on first page
\endfoot
\hline % Last foot in the last page
a&b\\
a&b\\

\end{longtable}

\usepackageftikz}

% Create numerated image

\begin{figure}

\begin{center}

% Draw Picture with tikz

\begin{tikzpicture} [scale = 2.0] % Start draw picture with specifying optional scale parameter
\draw[help lines] (0,0) grid (2,3); % Draw grid

\draw[<->] (0,3.5) - (0,0) - (2.5,0); % Draw axis via drawing polyline started and ended with arrows
\draw[red] (0,0)--(0,1)-(2,3); % Polyline in red line, default units are sentimeters
\draw/[green,
fill=yellow](0,0) circle [radius=0.5]; % Draw filled circle
\draw[domain=-2:2] plot (\x, \x*\x+2); % Draw graphic of functions
\node[below] at (1,1) {\tiny Circle}; % Text node
\end{tikzpicture}

\caption{Test Image}
\end{center}
\endf{figure}

7.4 Automatic Content Generation Command

Command Description

\listoffigures Generate list of figure and tables which contains “\caption”
\listoftables

\maketitle Generate Title for document

\tableofcontents Generate Table of content

\hrulefill

15



7.5 Special Commands for Articles

Command

Description

\begin{abstract}
A brief introduction about the subject.
\end{abstract}

Special dedicated environment block for writing abstract.

% In preamble
\theoremstyle{plain}
\newtheorem{theoremH{Theorem
naming in final doc}[section]

\newtheorem{proposition}[theorem]{Sta
tement in Latex}

% In main content
\begin{theorem} [Simple Theorem]

Define "Theorem" - special numerating user-defined object.
One possible example of usage is use it for math theorems
numeration.

Arg 1 - latex name (latex)

Arg 2 - human name in final document.

Arg 3 - numeration is scope of "section"

Proposition or statement. A proposition is a mathematical
statement such as "7 is prime." An axiom is a proposition
that is assumed to be true.

\label{theorem1}

Text of theorem. Proposition use share counter with theorems

\end{theorem}

\vspace{10ex} Insert vertical space 10 times higher than the height of
letter X.

\wfill Insert vertical space, so that the text after that will be

It will be locating in the bottom part of
page

located at the end of the page.

\usepackagefhyperref}

\url{https://www.google.com/}
\href{https://www.google.com/}
{Google Site}

Insert URL for external resource in the internet

\usepackage{multicol}

\begin{multicols{2}

\end{multicols}

Create two column environment to type in two columns
mode.

\usepackagef{cite}

% Work with bibliography
\usepackage{csquotes}

% Extra tools to work with references

We used derivation from
\cite{my_latex_reference}

Simple way to work with bibliography.
\addcontentsline — append Reference into \tableofcontents

{2} — used to provide number of references that you are
using.

Bibliographies description can be taken for example from:
https://scholar.google.com/

16
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It’s possible use several reference in one
citing command \citefref1, ref2}

Also it seems that this notation allow to
reference to specific page of another
document
\cite[p.78]{my_latex_reference}

\begin{thebibliography}{2}
%\addcontentsline{toc}{section}{\refnam
e}

\bibitem[Nice substitute name in doc
instead number]{my _latex_reference}
Long bibliographics description
\end{thebibliography}

\usepackage[backend=biber,bibencoding
=utf8]{biblatex}
\addbibresource{bib_db_1.bip}
\addbibresource{bib_db_2.bip}

BibLatex usage for citing things
https://ctan.org/pkg/biblatex

And add bibliographies databases in text format BibLatex

\printbibliography Generate complete list of literature for which we have
references or which we marked with \nocite
\citefid} \nocite{id} - ask generate it in final bibliography

\footcite{id} - small reference
\textcite{id} — reference with name of author and year
\cite{id} — usual bibliographic format

7.6 Special Commands for Presentations

Command

Description

\documentclass{beamer}
\documentclass[handout]{beamer}
\documentclass[aspectratio=169]{beame

r}

Presentation for PDF with different simple animations
Presentation with no animations for handout
Create presentation for monitors with aspect ratio 16:9

\usetheme{Berkley}
\usecolortheme{beaver}

\begin{document}
\begin{frame} \label{frame_1}

\maketitle
\end{frame}

Theme for presentation from https://hartwork.org/beamer-

theme-matrix/

Begin document

Slide for presentation with title.

Slide for presentation with a table of content.
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\begin{frame} \label{frame_2}
\tableofcontents
\end{frame}

\begin{frame}
\frametitle{My Title}
\framesubtitle{My Sub Title}
\end{frame}

\begin{document}

Slide for presentation. Content of frame is usual latex code
which contain formulas, images, tables, etc.

\begin{frame}
\frametitle{\insertsection}
\framesubtitle{\insertsubsection}
\end{frame}

Create slide for presentation.
Automatically generate section and subsection title for slide
based on current \section and \subsection

\begin{frame}

\alert{iImportant Text}

\pause % Not working in handout mode
\uncover

\only

\... <1-5>

\... <2->

\end{frame}

Insert important text into the slide.

Insert pause, can be inserted in any place in frame.

Text took place

Text do not take place

Command is valid during 1-5 click, after 6 click command is
ignored.

Show item from second click and up to the end of the
document.

\includeonlylectureflec2}
\lecture{Lecture One}{lec1}

\lecture{Lecture Two}{lec2}

Include only materials for lecture 2 into final PDF
Lecture One materials.

Lecture Two materials.

\input{preamble}

\includef{file}

Take “preamble” file and include text like it’s doing in
C-preprocessor. \input is not doing transferring to new

page.

Include file from other TEX source file like #include for C-
preprocessor. \include is forcing transferring to a new page.
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